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1 用語 

 

項目 内容 

本体 AEM1-D，AEM1-DA 表示部を指します。 

AD 値 センサーの出力を A/D 変換した生の値を指します。 

物理量 AD 値と検定定数から計算した流速値などを指します。 

Raw ファイル 
センサーの AD値を記録した測定データファイルです。 

Raw ファイルを処理することで物理量を確認できます。 

物理量ファイル 

（CSV ファイル） 

センサーの物理量を記録した測定データファイルです。 

Raw ファイルから物理量ファイルを作成できます。 

測定データ 本体で測定したデータを指します。 

ブロックデータ 本体内のメモリーに記録されている測定データを指します。 
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2 概要 

 

AEM1-D/DA 用ソフトウェア“AEM1-D/DA Data Transfer”は本体からパソコンへのデータ転送

用のソフトウェアです。本体で測定したブロックデータをご使用のパソコンに転送し，Raw

ファイルを作成します。 

作成した Raw ファイルを物理量 CSV ファイルへ変換できます。 

 

 

2.1 機能 

 

 ヘッダー情報受信機能 

本体や記録されているブロックデータの情報を確認できます。 

 

 データ転送機能 

本体に記録されているブロックデータをご使用のパソコンに転送します。また，ブ

ロックデータの消去（メモリークリアー）も可能です。 

 

 カレンダー設定機能 

本体の日時情報を設定できます。 

 

 CSV 変換機能 

Raw ファイルから物理量ファイル（CSV ファイル）へ変換できます。 
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2.2 対応機器 

 

当ソフトウェアは以下の機器で使用できます。 

 

 対象測器 

 AEM1-D 

 AEM1-DA 

 

 使用できるパソコン 

 

 ソフトウェア 

項目 仕様 

対応 OS 

Windows Vista 

Windows 7 

Windows 8 (8.1) 

Windows 10  

各 OS とも 32bit/64bit で使用可能 

その他 .NET Framework 4.0 以降 

               注釈：.NET Framework 4.0 以降は、Windows8 以降には標準で搭載されています。 

                     Windows7 以前で.NET Framework 4.0 以降をインストールする場合は、 

                     ７トラブルシューティングをご参照ください。 

 

 ハードウェア 

項目 説明 

スペック 上記 OS が問題なく動作すること 

その他 
通信用シリアルポート 

(USB シリアル変換ケーブルで代用可能) 

 

 

以降の操作説明は主に Windows 7 を，画面画像は Windows 10 を元にしています。他の

OS をご使用の場合は，ご使用の OS に読み替えてご利用ください。また，当ソフトを

Windows 8 以降で使用する場合は“デスクトップモード”でご利用ください。 
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2.3 接続例 

 

ご使用のパソコンのシリアルポートと本体をシリアルケーブルで接続します。（図 2.1）

パソコンにシリアルポートがない場合は USB シリアル変換ケーブルで代用できます。

（USB シリアル変換ケーブルを使用する場合は，あらかじめパソコンにドライバーをイ

ンストールしておいてください） 

接続完了後，本体の設定を通信モードに変更してください。 

本体の使用方法は本体付属の取扱説明書をご確認ください。 

 

 用意するもの 

 本体（付属の専用シリアルケーブルが必要です） 

 パソコン 

 シリアルケーブルもしくは USB シリアル変換ケーブル 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

シリアルケーブル 

もしくは 

USB 変換ケーブル 

パソコン 本体 

本体付属のシリアルケーブル 

図 2.1 接続例 
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3 インストールとアンインストール 

 

ご使用のパソコンへの当ソフトウェアのインストール方法とアンインストール（削除）方法

です。 

 

3.1 インストールする 

 

(1) 付属の CD-ROM をパソコンの CD-ROM ドライブに挿入します。 

(2) スタートメニューから [コンピューター] を開き，CD-ROM を挿入したドライブを選

択します（Windows 8 以降の場合はデスクトップよりエクスプローラーを使用して

CD-ROM を参照してください）。 

(3) 「setup.exe」 をダブルクリックします。 

(4) 下記の順序で画面が表示されますので指示にしたがってインストールしてください。 

 

インストールが完了すると，スタートメニューの[すべてのプログラム > JFE Advantech 

> AEM1-D & DA] 内にアイコンが作成されます。（図 3.1） 

   

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

  

(1) [Next>]で次へ (2)  [Next >]で次へ 

(3) [Next>]でインストールを開始 (4) [Close]でインストールを完了 
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 ご使用のパソコンの OS が Windows Vista 以降の場合,セキュリティの仕

様でインストール中に UAC（ユーザーアカウント制御）のダイアログが

表示される場合があります。 

 UAC のダイアログが表示された場合は[はい]を選択してインストールを

続行して下さい。 

 ご使用のパソコンの設定によっては UAC のダイアログが表示されない場

合がありますが異常ではありません。 

 

 

 

 

 

 

 

 

 

 

     UAC のダイアログの例 

 

 (2)でインストール先を変更できますが，既定のインストール先以外にイ

ンストール先を変更した場合は動作保証対象外となります。 

 

 

 

3.2 アンインストール（削除）する 

 

コントロールパネル内の“プログラムと機能”より“AEM1-D & DA Data Transfer”を選

択してアンインストールしてください。 

 

 

  

図 3.1 当ソフトのアイコン 
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4 起動と終了 

 

当ソフトの起動と終了方法です。 

 

4.1 起動方法 

 

スタートボタンより[すべてのプログラム > JFE Advantech > AEM1-D & DA]と選択し，

“AEM1-D & DA Data Transfer”をクリックすると起動します。 

 

4.2 終了方法 

 

ウィンドウ右上の“×”ボタンをクリックするか，“メインウィンドウ”の“File”メ

ニューより“Exit”を選択すると終了します。 

 

(a)“×”ボタン 

 

 

 

 

 

(b)“Exit”メニュー 

 

 

 

 

 

 

 

 

 

 

  

ここをクリック 

図 4.1 “×”ボタンでの終了 

(1) File をクリック 

(2) Exit をクリック 

図 4.2 “Exit”メニューでの終了 
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5 作業の流れ 

 

当ソフトを使用した作業の流れです。 

 

(1) 環境を用意する 

 パソコンと本体を接続します。（2.3 接続例 参照） 

 パソコンに当ソフトを用意します。（3.1 インストール 参照） 

 

(2) 当ソフトを起動して本体を準備する 

 当ソフトを起動します。（4.1 起動方法 参照） 

 本体を通信モードに設定します。 

 本体を接続したシリアルポートを当ソフトに設定します。 

 

(3) データ転送を行なう 

 本体に記録されているブロックデータをパソコンに転送します。 

 “Start Transfer”ボタンでデータ転送を開始します。 

 

(4) 必要があれば当ソフトの機能を利用して本体情報の確認やカレンダー設定を行なう 

 本体情報の確認やカレンダー情報を設定できます。 

 “Retrieve header”ボタンで本体情報を確認できます。 

 “Instrument clock”でカレンダー情報を設定できます。 

 

(5) 物理量ファイルに変換する 

 パソコンに転送したデータ（Raw ファイル）を物理量ファイルに変換します。 

 “Convert to CSV”ボタンで”Convert to CSV“ウィンドウが開きます。 

 “Convert to CSV”ウィンドウで物理量ファイルに変換します。 

 

(6) 終了する 

 データ転送中などで本体との通信中は終了できません。 

 “Disconnect”ボタンで本体の通信モードを解除できます。 

 当ソフトを終了します。（4.2 終了方法 参照） 
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6 画面説明 

 

本ソフトウェアの画面説明です。 

 

6.1 メインウィンドウ 

 

当ソフトのメインとなるウィンドウです。（図 6.1） 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

メニューバーやツールバーで操作を行ないます。制御部で本体の制御を行ないます。 

 

項目 説明 

メニューバー 6.1.1 メニューバー 参照 

ツールバー 6.1.2 ツールバー 参照 

ステータスバー 6.1.3 ステータスバー 参照 

制御部 6.1.4 制御部 参照 

 

  

図 6.1 メインウィンドウ 

メニューバー 

ステータスバー 

制御部 

ツールバー 
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6.1.1 メニューバー 

 

主に終了や設定などの，当ソフトに関する操作を行います（図 6.2） 

 

 

 

 

(a)“File”メニュー 

項目 説明 

Convert to CSV 

CSV 変換ウィンドウを表示します。 

（6.2CSV 変換ウィンドウ 参照） 

Raw ファイルより物理量ファイルに変換します。 

Exit 
当ソフトを終了します。（4.2 終了方法 参照） 

本体との通信中は終了できませんのでご注意ください。 

 

(b)“Tools”メニュー 

項目 説明 

Memory Clear 

本体内のメモリーを初期化します。 

記録されているブロックデータは全て削除されます（特定

のブロックのみを削除することはできません）。削除され

たブロックデータは元に戻せませんのでご注意ください。 

Option 
オプションウィンドウを表示します。 

（“6.3 オプションウィンドウ”参照） 

 

(c)“Help”メニュー 

項目 説明 

About 
バージョン情報ウィンドウを表示します。 

（“6.4 バージョン情報ウィンドウ”参照） 

 

  

図 6.2 メニューバー 
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6.1.2 ツールバー 

 

通信ポートの設定や本体の通信モード変更を行います。（図 6.3） 

 

 

 

 

項目 説明 

Convert to CSV 
“Convert to CSV”ウィンドウを表示します。 

Raw ファイルから物理量ファイルに変換します。 

Port number 
本体との通信に使用するシリアルポートを設定します。使用する

ポートが表示されない時は“Re-scan”ボタンで再検索できます。 

Re-scan パソコン上のシリアルポートを再検索します。 

Disconnect 

シリアルポートに接続している本体の通信モードを解除します。 

通信モードを解除すると通信できなくなりますので，再度通信を

行なう場合は本体側で通信モードに設定してください。 

 

 

6.1.3 ステータスバー 

 

当ソフトの現在の状態を表示します。（図 6.4） 

 

 

 

 

 

 

 

 

 

  

図 6.3 ツールバー 

図 6.4 ステータスバーの説明 

時計 現在の状態 
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6.1.4 制御部 

 

本体との通信処理を行ないます。（図 6.5） 

 

 

 

 

 

 

 

 

 

 

 

 

 

本体情報で本体の設定を確認できます。カレンダー設定で本体のカレンダー情報を

設定できます。データ転送部で本体のブロックデータをパソコンに転送します。 

 

項目 説明 

本体情報 本体から本体情報を取得して確認します。 

カレンダー設定 
本体のカレンダー情報の確認と設定ができます。 

パソコンのカレンダー情報を本体に設定することもできます。 

データ転送部 

本体内のメモリーに記録されているブロックデータをパソコ

ンに Raw ファイルとして転送します。本体の仕様により転送す

るブロックデータを選択して転送することはできません。 

 

  

カレンダー設定 

データ転送部 

本体情報 

図 6.5 制御部 
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 本体情報 6.1.4.1

 

本体情報を本体より取得して表示します。（図 6.6） 

    

 

 

 

 

 

 

項目 説明 

Retrieve header 
本体より本体情報を取得します。 

下記情報の他にブロック数と総データ数も取得します。 

Serial No. 本体のシリアルナンバーです。 

Version 
本体のファームウェアのバージョンです。本体に問題が発生し

た時のお問い合わせの際に一緒にお知らせください。 

 

 

 カレンダー設定 6.1.4.2

 

本体のカレンダー情報の取得と設定を行ないます。（図 6.7） 

 

 

 

 

 

 

 

項目 説明 

Read clock 本体よりカレンダー情報を取得して表示します。 

Save clock 入力したカレンダー情報を本体に設定します。 

Sync with PC 
チェックを ON にするとパソコンのカレンダー情報を本体に設

定します。（入力している設定は無視します） 

 

  

図 6.6 本体情報 

図 6.7 カレンダー設定 
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 データ転送部 6.1.4.3

 

本体に記録されているブロックデータをパソコンに転送します。（図 6.8） 

 

 

 

 

 

 

 

 

 

 

 

 

項目 説明 

Data information 

本体に記録されているブロックデータの情報です。 

Total data block(s)：ブロック数  

Total data num.    ：総データ数 

Sensor calibrated on 
Raw ファイルに出力する本体の検定情報です。 

Date:検定日 

Save in folder 
Raw ファイルを出力するフォルダーを指定します。 

“Open”ボタンで転送先を変更できます。 

Files name 

転送時に作成する Raw ファイルのファイル名を指定しま

す。ファイル名の後ろにブロック№を追加します。 

拡張子は不要です。 

（例） abcd と指定した場合 abcd_ブロック№.raw  

Auto generation 

ファイル名を転送開始した日時より自動生成します。 

ON：自動生成します  OFF：手入力してください 

（例）4月 17日 10:01 の場合 04171001 

Start transfer 

データ転送を開始します。先に“Retrieve header“で本体

情報を受信しないと使用できません。 

- 転送開始前に開始確認のダイアログが表示されます 

- 転送の途中でキャンセルできます 

- 既存のファイルは上書きされますのでご注意ください 

  

図 6.8 データ転送部 
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 データ転送の手順 

 

(1) 本体とパソコンを接続します。ポート名を設定し，本体を通信モードに 

します。（2.3 接続例，エラー! 参照元が見つかりません。エラー! 参照元

が見つかりません。 参照） 

(2) “Retrieve header”で本体情報を受信します。（6.1.4.1 本体情報 参

照） ”Start transfer”ボタンが使用できるようになります。 

(3) 必要があれば転送先のフォルダーとファイル名の設定を変更します。 

(4) “Start transfer”ボタンをクリックします。開始確認のダイアログが表示

されますので，問題なければ“はい”をクリックすると転送を開始します。 

 

 
 既存のファイルは上書きされますのでご注意ください。 

 

 転送時間の目安 

データ量 時間 

フルデータ 約 35分 

10000 データ 約 20秒 

 

(5) 転送の進捗状態が表示されますので，転送完了までお待ちください。（図 6.9）

“Cancel”ボタンでいつでもデータ転送を中止できます。 

（転送途中のブロックデータの Raw ファイルは削除されますが，完了してい

るブロックデータの Raw ファイルはそのまま残ります） 

 

 

 

 

 

 

 

(6) 転送を完了するとダイアログが表示されます。（図 6.10） 

 

 

 

 

  

図 6.9 進捗状況 

図 6.10 完了ダイアログ 
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6.2 CSV 変換ウィンドウ 

 

Raw ファイルから物理量ファイルへの変換を行います。（図 6.11） 

“Convert to CSV”アイコンをクリックするか[File > Convert to CSV]と選択すると 

表示されます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

項目 説明 

Files List 物理量ファイルに変換するファイルの一覧を表示します。 

Add 
ファイルリストに Raw ファイルを追加します。 

複数のファイルを一度に追加できます。 

Delete 
ファイルリストで選択しているファイルをリストから削除

します。 

Clear 
ファイルリストに登録されている全てのファイルをリスト

から削除します。 

Save in folder 
物理量ファイルの保存先フォルダーを表示します。“Open”

ボタンで保存先を変更できます。 

Start conversion 

物理量ファイルへの変換処理を開始します。 

- 変換処理の開始前に開始確認のダイアログが表示され

ます 

- 変換処理の途中でキャンセルできます 

- 既存のファイルは上書きされますのでご注意ください 

Cancel CSV 変換ウィンドウを閉じます。 

 

ファイルリスト 

図 6.11 CSV 変換ウィンドウ 
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6.2.1 CSV 変換の手順 

 

(1) CSV 変換ウィンドウを開きます。 

(2) “Add”ボタンで物理量ファイルに変換したい Raw ファイルを“ファイルリスト”

に追加します。 

 “Delete”ボタン，“Clear”ボタンでファイルリストから削除できます。 

 

(3) 必要があれば“Open”ボタンで物理量ファイルの保存先フォルダーを変更しま

す。 

 

(4) “Start conversion” ボタンをクリックします。開始確認のダイアログが表示

されますので，問題なければ“はい”をクリックすると変換処理を開始します。 

 

 
 既存のファイルは上書きされますのでご注意ください。 

 

(5) 変換処理中は進捗状況が表示されます。“Cancel”ボタンでいつでも中断でき

ます。（図 6.12） 

 

 

 

 

 

 

 

 

 

(6) 変換処理が完了するとダイアログが表示されます。（図 6.13） 

 

 

 

 

 

 

 

 

  

図 6.12 進捗状況 

図 6.13 完了ダイアログ 
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6.3 オプションウィンドウ 

 

当ソフトの設定を変更します。（図 6.14） 

[Tools > Option]と選択すると表示されます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(1) Folder 

各ファイルを保存するフォルダーを設定します。“Open”ボタンで変更します。 

項目 説明 

Data Raw ファイルを保存するフォルダーです 

Use this folder as 

default 

各ファイルを最後に開いたフォルダーを記憶して，次回使用

時の初期フォルダーにします。ONにすると“Data”フォルダ

ーは変更できません。 

Log 通信ログファイルを保存するフォルダーです。 

 

(2) Data transfer 

データ転送に関する設定を行ないます 

項目 説明 

Save binary files. 

ONにするとデータ転送時に転送したメモリーをバイナリーフ

ァイルに保存します。ファイル名は Raw ファイルと同じにな

ります（拡張子は“.bin”）。 

 

  

図 6.14 オプションウィンドウ 
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(3) Communication 

通信に関する設定を行ないます 

 

項目 説明 

Timeout 
通信タイムアウトの時間を設定します。 

単位:ミリ秒 既定値：5000 

Data transfer 

stand-by time 

データ転送時のコマンド送信後の待機時間を設定します。通

常は変更する必要はありません。 

単位：ミリ秒 既定値：100 

 

 

6.4 バージョン情報ウィンドウ 

 

当ソフトのバージョン情報を表示します。（図 6.15） 

[Help > About]と選択すると表示されます。 

 

  

 

 

 

 

 

 

 

 

不具合などの問題が発生しましたらウィンドウに表示されているバージョン情報も一緒

にご連絡ください。 

 

 

  

図 6.15 バージョン情報ウィンドウ 
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7 トラブルシューティング 

 

 ソフトが起動できない 

 スタートボタンより起動して下さい(“4.1 起動方法”参照) 

 .NET Framework 4.0 以降がご使用のパソコンにインストールされているかご確認 

ください。 

.NET Framework 4.0 以降がインストールされていない場合は、インターネット 

のマイクロソフト社のサイトで、.NET Framework を検索し、最新の 

.NET Framework 4.0 以降をダウンロードし、インストールしてください。 

 

 ソフトの設定が壊れている場合があります。コマンドラインオプションに”-CLEAR”

を指定して起動してください（設定は全て初期化されます）。 

 

 シリアルポートが指定できない（表示されない） 

 “Re-scan”ボタンをクリックしてパソコン上のシリアルポートを再検索してくださ

い。 

 デバイスマネージャーでポート名が正しいか確認してください 

 USB シリアル変換ケーブルのドライバーがご使用のパソコンにインストールされて

いるかご確認ください。 

 

 本体と通信できない，通信が頻繁に切れる 

 本体の電源が入っているかご確認ください。 

 本体が通信モードになっているかご確認ください。 

 電源に電池を使用している場合は電池容量をご確認ください。 

 ポート名が正しく設定されているかご確認ください。 

 

 CSV 変換ウィンドウでファイルリストに追加できない 

 同じファイル名の Raw ファイルは保存しているフォルダーが異なっていても出力先

の物理量ファイルが同じファイル名となるため追加できません。 

 

 

 

 

 

  



 

21 

 

8 保証 

 

本製品に関しましては，以下の保証が適用されています。 

 

(1) ソフトウェア納入後，1 年間を保証期間と定め，保証期間内に発生した設計上，製造上の瑕疵に

よる故障，或いは正常なご使用状態に於いて発生した故障であると判断した場合は無償で交換

をいたします。 

 

(2) 付属品，梱包類等は保証範囲外とします。 

 

(3) 保証期間内であっても次のような場合には，有償扱いとなりますのでご注意ください。 

① 誤操作，不注意によって生じた故障 

② 当社以外での不当な改造で発生した故障 

③ 購入後の輸送，落下，衝撃等による故障 

④ 火災，地震，水害，落雷，その他の自然災害，公害や異常電圧、腐食性ガス・有機溶

剤・化学薬品溶液等の付着など，外部要因によって生じた故障及び損傷 

⑤ 接続する他の機器の異常により生じた故障及び損傷 

⑥ 当社製品以外(お客様の装置やソフトウェア等)が原因による故障 

 

(4)  本機の使用により生じた損害，逸失利益または第三者からのいかなる請求につきましても，当

社では一切その責任を負えませんので，あらかじめご了承ください。 
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